
 

EFFICIENT CLIENT INTAKE WITH TIME MATTERS 
 

An efficient client intake process boosts productivity and 
enhances your ability to market your firm. 

continued 
 

There are a number of reasons why developing and using an intake 
process within your practice management system makes a lot of sense.  
The first part of this paper will focus on some of the reasons why you 
should develop an intake process.  Later, I will discuss some of the ways to 
make it happen. 
 

Streamline Workflow to Process Files More Efficiently 

The first reason to create a workflow within Time Matters or any other 
practice management system is to streamline workflow within your office.  
A well designed and consistently used intake process ensures that your 
files are opened correctly and makes it far less likely that they will fall 
through the cracks or otherwise cause problems later. 
 
Many offices have an intake process and a file management system.  The 
problem is that the system is not documented, is seldom reviewed and is 
not always followed.  When your intake and other file management 
processes are documented, the administrative aspects of your files follow a 
specific set of rules as they progress through your office.  Once your 
processes are documented, it becomes far easier to consistently 
completely tasks and to train new employees to perform those tasks.  In 
addition, it gives your attorneys and staff confidence in the system and 
makes it possible to identify and correct issues in the process. 
 

Collect the Information You Need 

Every file requires that you collect certain information from your client.  
There are certain obvious pieces of information such as the client’s name, 
address and other contact information.  What other information would you 
find valuable?  Perhaps you would like to begin sending your clients 
birthday or anniversary cards.  Are you collecting these dates?  What about 
their spouse’s name or hobbies?  Do you even know how that client 
learned about your services?  There are so many pieces of information that 
are useful for marketing and other purposes.  If your intake process 
requires specific information, your staff is much more likely to gather it. 
 

 



 
 
 
 
 

Phone Inquiries 

Related to both streamlining and information gathering is the topic of phone inquiries.  In a sense, this 
is pre-intake information.  However, it really is the beginning of the file intake process – at least you 
hope so.  Much of the information you want to collect gets asked verbally during the initial phone 
inquiry.  Are you capturing it? 
 

Avoid Conflict Issues 

Conflict checking is an integral and necessary part of practicing law.  An intake process needs to 
make sure that a conflict check is performed, is made against the correct data and is properly 
interpreted and acted upon.  Your intake process can easily meet all of these requirements. 
 

Use Less Paper 

A final reason to streamline and automate your intake process is to use and retain less paper.  It is 
possible to use your electronic practice management system in a way that eliminates much of the 
paper you are currently creating as part of file administration.  If your information is collected and 
stored correctly, there is no need for file info sheets.  Checklists can be stored electronically, 
documents can be scanned and stored electronically and many other administrative tasks can be 
incorporated into your file intake process.   
 

How? 

Phone Inquiries 

Efficiently processing phone inquiries is about five things. 
 
First, you need to make sure the Phone Call Form includes fields for all of the vital information.  There 
is quite a bit on the form already but don’t forget that you have 8 User (version 8 and earlier) or 
Custom (version 9 and higher) fields that you can modify.  If you cannot see them, open a Phone 
Form, select the View Menu, then User Area.  I will talk about customization in more detail later. 
 
Second, you need to make it easy for your staff to create and complete a Phone Call Form.  The 
simplest way to do this is to make sure that the Add Phone button is on their toolbar.  Right click on 
your toolbar and select Customize to add buttons. 
 

 
 

Third, you have to make sure that you are using the Time Matters Messenger to route the phone calls 



 
 
 
 

as appropriate.  Just make sure that the recipients of the messages know how to use the Messenger 
to check their calls. 
 
Fourth, your attorneys need to understand the Phone List.  This is the list of all calls the attorney has 
received. 
 
Finally, invest in some training so that everyone knows how the features above work and how they are 
supposed to use them. 

Conflict Searching 

A thorough conflict search is vital to the intake process.  Time Matters offers two ways to search 
everything within the database.  More accurately, there is one way with two methods for accessing the 
search.  The simplest way is available only in version 9 and higher. 
 

 
 

To search, simply locate the Search All Records box on your toolbar (add it to your toolbar if it is not 
already there) and type a search name/term/phrase. 
All records found by Time Matters will appear in the search results window. 
 

 
 
You can perform the same search by selecting the Search Menu, Global Search.  This method also 
works in versions earlier than 9.  However, keep in mind that Time Matters 8 and earlier will take much 
longer to process this type of search. 



 
 
 
 
  

Setup Time Matters to Collect the Information You Need 

If you are going to collect information in Time Matters, the program must be customized in order to 
store and track the information.  Your first challenge is to determine what information you would like to 
collect and exactly how you want to gather and store that information.  Start by reviewing your current 
file sheets for the information you are currently collecting.  Determine what information, if any, you 
would like to collect but are not currently gathering.  You also need to note any information that must 
be shared between your systems. 
 
The next step is to determine where the information will be stored in Time Matters.  In all likelihood, 
some information will be stored on the client’s Contact record and some will be stored on the Matter 
record.  In Time Matters, the general rule is that information on Contact forms is rather static 
information about a person or entity.  Names, addresses and phone numbers change but not that 
often.  Matter information, on the other hand, tends to be unique to that single matter.  Currently, Time 
Matters does not support tab ordering, so you will need to lay out the information on your forms in a 
logical and consistent manner.  This makes it easier for your staff to enter the information. 
 
Now that you have the information you want to collect, it is time to customize Time Matters to hold that 
information.  Customize Time Matters forms by opening the Form Styles interface under the File 
Menu, Setup, Templates, Form Styles.  Locate the field you want to customize and right click on it.  
Select Customize Field. 
 

 
 

Give the field a name including a screen label (the name that appears in front of the field) and a 
screen tool tip (the popup that appears when you hover over the field).  Depending on the specific 
information required, choose a data type from the choices on the left side of the screen and select 



 
 
 
 
 options in the middle. 

 
One of the options is to make a field required.  Where appropriate, you can make a field required so 
that it must be entered when the file is created.  This is very useful.  However, use it judiciously.  If you 
make too many fields required, it will slow the intake process and make it more difficult for your staff to 
perform the intake process. 
 

Create, Document and Update Processes 

You have setup Time Matters to hold and process the information you want about your clients.  The 
next step is to detail in a specific checklist all of the things that make up your intake process in the 
order that they must happen.  There are a lot of reasons to do this. 
 
First, what good is an intake process that is not being followed?  As I will show you, this can easily be 
done electronically in Time Matters.  However, if you require something more concrete, this might be 
the one piece of paper that should be printed on every file.  This ensures that each and every file is 
opened in the same way every time.  Consistency! 
 
Second, documenting processes is a great way to get staff involved.  What I am referring to is “buy-
in.”  Ask the intake personnel to become involved in putting the checklist together and they have an 
interest in making it work. 
 
Third, who is going to know and understand your intake process if your intake person walks into your 
office and quits tomorrow.  Creating a checklist is an insurance policy for your business.  For this 
same reason, your checklist needs to be so simple that anyone can follow it.  To quote a phrase from 
a colleague, your checklist should be “Monday Proof” and “Monkey Proof.”  This means it works every 
time, even on those bad days, and works no matter who is doing it. 
 
Now, here is a specific way to create a checklist in Time Matters. 
 
Time Matters actually gives you two ways to create a checklist.  The first method is a Chain Template.  
However, Chain Templates are more useful when the checklist involves a long period of time and 
specific timeframes between items.  We are going to focus on the second method for creating 
checklists in Time Matters – Outlines. 
 
Time Matters Outlines are a great way to create a checklist because they allow for any number of 
steps to be placed in a list and in whatever order you choose.  They can be placed in a template so 
that they can easily be copied to any new file.  They are very flexible, so you can have different 
checklists for different types of files.  Finally, they allow you to create other Time Matters records tied 
to the Outline. 
 
To create a simple Outline simply open a Matter, select the Outline tab and add a new one.  However, 
for your checklists you will want to create them as AutoEntry Forms.  AutoEntry Forms are created 
from the File Menu, Setup, Templates, AutoEntry Forms selection.  Select Outline as your record type, 
then add a new one. 
 

 
 



 
 
 
 
 
 

Select Program Level so that your new Outline is accessible to everyone and list your steps in the 
lower portion of the screen. 
 

 
 
In my simple example, I have created a five step process with some of the steps having sub-steps.  
Save the AutoEntry Form. 
 
Once created, the AutoEntry Form should be attached to every new file and each step should be 
marked done as appropriate.  To attach the AutoEntry Form, open a new Outline Form, select the 
AutoEntry Form and make sure it is attached to the correct new Matter.  An AutoEntry Form is 
selected by clicking the AutoEntry Form button within the Outline record. 
 

 
 
Finally, make sure you mark items off your checklist as they are completed.  Simply right click any 
item in the list to mark it done. 
 



 
 
 
 
 

 
 

Automate Time Matters to Avoid Repetitive Data Entry 

An AutoEntry form is only the first step to automating Time Matters.  It is also possible to call up 
AutoEntry Forms in various ways and to combine them with Time Matters Triggers.  Triggers are 
found under the File Menu, Setup, Templates, Trigger.  You can create a Trigger for any type of Time 
Matters record. 
 
Examples of useful Triggers for the file intake process are: 
 

1. A Trigger that creates a Matter for the currently selected Contact record 
2. A Trigger that creates a Matter of a specific type 
3. A Trigger that completes a portion of the Matter record based on the manner in which the 

Contact record was filled out 
 

Connect Time Matters to Other Applications 

Time Matters features links to many popular applications including most legal specific billing systems.  
These links allow you to send information between Time Matters and these other applications.  These 
links should be a part of your intake process for two reasons.  First, the ability to send information 
between Time Matters and other applications often means that you only have to enter it in one place 
rather than two.  Second, the ability to share information makes it much more likely you will have 
accurate information in both because your staff will not update one and forget to update the other. 
 
Setup a Time Matters link to your billing application through Program Level Setup.  This can be found 
under the File Menu, Setup, General, Program Level.  Select Links and choose an application to link 



 
 
 
 
 with.  

 

 
 
Once an application is selected, additional screens allow you to define the specific items you would 
like to synchronize, the way information will pass back and forth, and other settings. 
 

Scan and Save to Time Matters 

Now that you have an electronic intake process to add your new clients and matters into the system, 
do you really need all of that paper you are currently holding onto?  Time Matters document 
management allows you to save documents and find them later using a variety of search methods.  
With regard to the intake process, one of the most important features of document management is the 
ability to scan and save documents.  There are two critical aspects to scanning documents and saving 
them to Time Matters.  The first is the type of document that is created from the scan.  The second is 
the method by which scans are created. 
 
The most flexible file format for your scanned documents is PDF.  PDF scans are preferable because 
Time Matters installs a TM Save button on the toolbar of Adobe Acrobat.  This allows you to save any 
PDF to Time Matters by simply opening the scan and clicking TM Save. 
 
Finally, there are several methods of scanning to Time Matters.  With the right scanner, you can 
create a document record and have Time Matters pull your scan through the scanner.  This is referred 
to as “pull” scanning.  “Push” scanning, on the other hand, is where the scan is run and software 
pushes it to a useful location. 
 
One of the simplest and least expensive ways to scan to Time Matters is by using the Fujitsu 
ScanSnap.  The ScanSnap ships with a full version of Adobe Acrobat Standard and allows you to 
“push” scans directly to Acrobat.  Once in Acrobat, documents are one click from being saved in Time 
Matters, thanks to the TM Save button. 

 
 
 



 
 
 
 
 
 
 

Test and Measure 

Time Matters has a number of built in reports and ways to analyze your data.  Now that you have all of 
this data, do something with it!  Simple ways to use Time Matters for reports include Lists, Sub-lists 
and Quick Tabs.  For now, let’s focus on Quick Tabs. 
User Level (only you can use them) Quick Tabs can be created on any list.  Simply, right click on any 
existing tab or select the Edit Menu, then Options.  Complete the form as appropriate for your Quick 
Tab, especially with regard to the fields you want to display and which search to run. 
 

 
 

 
 



 

Here are some examples of Quick Tabs you might want to consider. 
 

1. A Matter List tab that shows all Matters where no RefSource was 
entered so that you can identify Matters where intake missed this 
critical information. 

2. A Matter List tab that shows all Matters resulting from the Ad #1 ran 
in the local community newspaper. 

3. A Matter List tab that shows all Matters for the past year, sorted by 
the Referral Source. 

 
The possibilities are endless but the point is to run reports and look at them 
frequently.  If Ad #1 cost you $500 to run and produced 10 clients, your cost 
per client is $50.  If Ad #2 cost you $1000 and brought in 14 clients, your 
cost per client is $71.43.  Which one was more effective? 
 
Now add the value of the case to each Matter.  Is the story different?  
Perhaps your $1000 investment in Ad #2 brought in cases worth much more 
on average than those brought in by Ad #1. 
 
Hopefully, you are beginning to see the advantages to testing and 
measuring.  
 
 

Conclusion 

Efficient workflow within your office begins with an efficient intake process.  
Time Matters can be customized with fields allowing you to capture 
necessary information regarding phone inquiries, prospective clients and 
new matters.  By capturing this information, your firm can more effectively 
process files and move them efficiently through the office.  This information 
is also valuable for reporting, marketing and other purposes but it all begins 
with collecting it in the first place.  
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